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Chapter 1 - Opening and Saving
One of the more commonly used tasks accompanied with using Microsoft Word is the
ability to Open and Save your documents.

Opening a New Blank Document

When you open Word, you are presented with a New Document. Examine the Title
bar; it states the current name of the document you are viewing (in our case
“Document1”). This is a temporary name until you save your document. In this lesson
we will discover the different options for opening Word documents.

1. Launch Microsoft Word by clicking on the Start button, point to All
Programs, point to Microsoft Office and click on Microsoft Word 2003.
Note: the exact Start menu location may vary. Or you may choose to
double-click on the appropriate desktop icon.

2. Word opens with a new (blank) “Document1”.
3. You may choose to enter text immediately, but it is highly recommended at

your earliest convience, to Save your document (we will discuss this topic in
a moment).

4. Once you are finished with your document you may Save and close it so it
can be retrieved in the future.

If you close all active documents, you are faced with a light gray background. You can
choose to open another blank document or an already existing document.

1. With all documents closed, click on the File menu and select New. (toolbar
shortcut )

The New Document pane appears. Note the options for a new document. In our case
we will select Blank document.

2. Click on the Blank document link. Instantly, we see the new document on
our screen named Document2.

3. Once again, you may enter text as you see fit.
4. Close your document without saving using Close Document button.

Opening an Existing Document

For obvious reasons, we save documents so we can retrieve them later. Knowing
where your documents are located is quite important. You may wish to open a
particular document to copy information to another document. Just another reason to
save our documents.

Close document button
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1. To open an existing document, click on File menu, and select Open. The
Open dialog box appears.

2. Once you have located the file you wish to open, either double-click the file
name or click once to select the file and then click on the Open button. The
document will appear on your screen.

3. Once again you may choose to modify, copy, etc to your document. Close
your document.

Copying or Deleting Documents
We can use the Open dialog box to achieve other tasks, beyond opening an existing
document.

1. Click on the Open tool from our Word toolbar . The Open dialog box
appears.

2. Select any document from the list shown. Right-click and choose Copy.
3. Click in any open space in the file list.
4. Right-click and choose Paste. A “Copy of filename” appears.
5. Right-click the newly created (copy) document and choose Delete from the

menu. The Delete File confirmation dialog box appears. Click on the Yes
button. The document is sent to the Recycle Bin.

6. You may close the Open dialog box by clicking on the Cancel button or the
Close button (top right corner of the dialog box).

Saving a Document (first time)

Once you have created a new document, you should get in the habit of Saving (early
and frequently). You never know when accidents may occur.

1. To save a document for the first time, click on File and choose Save.
(toolbar shortcut ).

NOTE – It may be necessary to change the Look in field to another location,
depending on where the document resides. In addition the left pane offers you
shortcuts to navigate to popular locations. Also, it may be necessary to change the
Files of type to another selection, depending on the file extension of your
document. For instance, choosing Text File will allow you to view only files that end
with .TXT
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The Save as dialog box appears.

2. Note: it may be necessary to change the Save in field to a different location.
3. In the File name field enter your new document name, you may omit the

.DOC extension, as Word will automatically add the proper extension in the
Save process.

4. Click on the Save button. The new name appears in the Title bar.

Saving a Document (thereafter)

1. Once we have initially saved our document, we can choose to Save our
document by clicking on the Save tool , or by using the keyboard

shortcut keyb + S.

Saving a Document (with a different name or location)

You may wish to change the name or save your document to a different location.
Follow these steps to achieve this task.

1. Choose File from the menu, and click on Save As. The Save As dialog box
appears.

2. If you are changing the name, highlight the File name and type the new
name.

3. If you are changing the location, select the new location from the Save in
field.

4. Once you have completed your selection or options, click on the Save button

J. Allen Olshen
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Chapter 2 - Selecting Text
While editing text in Microsoft Word, we discover one of the most important factors is
being able to select text in a timely manner. The following steps will provide you with
many options for selecting (highlighting) text so that it may be modified, copied or
moved.

Selecting Text with your Mouse

We can select various amounts of text with a few basic skills using our mouse or
combined with our keyboard.

5. If necessary, launch Microsoft Word (by clicking on the Start button, point
to All Programs, point to Microsoft Office and click on Microsoft Word
2003). Note: the exact menu location may vary. Or you may choose to
double-click on the appropriate desktop icon.

6. Type the following (intentionally omitting ‘good’):
“Now is the time for all men to come to the aid of their country.”

Selecting one word

Selecting one word is quickly achieved by double-clicking the single word.
1. To select (highlight) one individual word in your document, hover over the

word you wish to modify with your I-beam and double-click with your left
mouse button. The word now becomes highlighted.

2. If we want to add additional ‘words’ to our above selection, simply hold down

thej key and click your mouse at the end of the last word you wish to

select. Now all text from the initial word to last word you chose will be
selected.

3. An alternate method to the above is to double-click on the first word we wish
to select and drag to the last word. Microsoft Word highlights a word at a
time, making it easier to select entire words.

Selecting a Paragraph

Selecting an entire paragraph can be achieved quickly by triple-clicking (with our I-
beam) anywhere within the paragraph we wish to modify.

1. Hover over the paragraph you wish to select with your I-beam pointer. Triple-
click with your mouse. The entire paragraph becomes highlighted.

J. Allen Olshen
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Selecting a Row of Text

Selecting any given row or rows of text can be achieved quickly, by positioning your
mouse pointer in the left column (where you mouse pointer converts into a right-
pointing arrow and clicking or you may click and drag several rows of text.

1. Position your mouse pointer in the left margin region, where your pointer
converts into an arrow pointing to the right, adjacent to the line you wish to
select (shown here in the left margin).

2. Click your mouse to select the line of text.
3. If you wish to select more than one line of text, click and drag to the last line

you wish to select. Once you release your mouse button, all lines will be
selected.

Selecting a given amount of text

Often we may want to select more or less text than one word, or a paragraph. This can
be accomplished quite easy with a combination of your mouse and keyboard. This
method is clearly a very useful method of selecting text in other programs as well.

1. With your I-beam, click at the beginning of the text you wish to select. Your
cursor should be flashing directly in front of the first character you are
selecting.

2. Next we will hover over the last character we wish to select with our I-beam.

While holding down thej key, click at the position desired.

Selecting Text with your Keyboard

Selecting text with your keyboard can be achieved quickly and efficiently. We will
examine a few of the more common methods of selecting text.

Selecting a given portion of a Row

1. Position your cursor at the beginning of the text you wish to select.

J. Allen Olshen
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2. While holding down thej key, press thed key. The entire text from

where your cursor was located to the end of the row is selected.

Selecting Multiple Words

To select multiple words in your document, follow the procedure below:

1. Click in front of the first word you wish to select.

2. While holding down thej +b keys, press the right arrow key once

for each word you wish to select. You may press the right arrow key as many
times as you so desire, to select multiple words.

Selecting from any location to the beginning of the document

We may want to select a large amount of text, starting from the beginning of the
document to a specific location within our document. This can be done quickly, with
little effort.

1. Position your cursor at the end of the text you wish to select.

2. From your keyboard, pressj + b +g keys. This selects from

your former cursor location to the beginning of the document.

Selecting from any location to the end of the document

We may want to select a large amount of text, starting from a specific location to the
end of our document. This can be done quickly, with little effort.

3. Position your cursor at the beginning of the text you wish to select.

4. From your keyboard, pressj + b +d keys. This selects from

your former cursor location to the end of the document.

NOTE – Once you have selected any text, you may immediately start typing to
replace the former text. There is no need to press the delete key prior to enter your
new text.

J. Allen Olshen
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Chapter 3 - Adding, Deleting, Moving and Copying
Often we may want to modify the text in our Microsoft Word document. In this next
topic, we will discuss adding, deleting, moving and copying text within a document.

Adding Text

1. To add text to your document, with your I-beam, click at the location you
wish to add a character, word or sentence. Your cursor will be blinking at the
location you clicked in your document.

2. Once your cursor is properly positioned, start typing the information you wish
to add to your document. You may add one character a sentence or several
pages.

Deleting Text

Often we may want to delete a character, word, sentence or large portion of our
document. Using the following techniques will help to enhance your experience.

1. To delete text, we must first select the text to be deleted. Select the desired
text (using the methods previous discussed in “Selecting Text”).

2. Once the text you wish to delete is selected, press thec key on your

keyboard. The highlighted text will be removed from your document and the
remainder of the document will replaced the deleted text.

Moving Text

At times we may want to move text from one location within our document to another.
This action removes the text from one located and places it at a different location.

1. Select the text you wish to move (using the methods previous discussed in
“Selecting Text”).

2. From the Edit menu, select Cut (shortcut:b+X). The highlighted text

within your document temporarily disappears.
3. Position your cursor at the exact location you wish the text to be inserted.

4. From the Edit menu, select Paste (shortcut:b+V). The text that was

‘cut’ is now repositioned at the new location in your document.

Copying Text

We may want to duplicate a portion of our document (copying). You may copy the
selected text multiple times in the same document or in another document.

NOTE – You may wish to move the cursor left or right one or two characters before
you begin typing. Using the appropriate arrow keys on your keyboard will position
your cursor accordingly.

J. Allen Olshen
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1. Select the text you wish to copy (using the methods previous discussed in
“Selecting Text”).

2. From the Edit menu, select Copy (shortcut:b+C). Nothing seems to

have changed in your document, as you’ve only copied the selection.
3. Position your cursor at the exact location you wish the text to be placed.

4. From the Edit menu, select Paste (shortcut:b+V). The text that was

‘copied’ is now duplicated at the new location in your document.

J. Allen Olshen
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Chapter 4 - Modifying the Size and Appearance of
Text
Often we may want to modify the look and appearance of text in our Microsoft Word
document. This next exercise will show you how simple it is to change the appearance
of text within your Microsoft Word document.

Changing the Font and Size of Text

We may have the need to change the font or size of text. Follow these steps to
accomplish this task.

1. Select the text you wish to modify (using the methods previous discussed in
“Selecting Text”).

2. From the toolbar click on the Font drop-down
list.

The Font drop-down list appears, displaying the available fonts. In our case we will
select Times New Roman.

3. From the toolbar click on Bold.

4. From the toolbar click on the Font Size drop-down list
select 10 (10 points).

Additionally we may open the Font dial box, by choosing Format from the menu and
selecting Font.

5. Note the changes we have just made above are reflected in the highlighted
text..

NOTE – When dealing with Font sizes, 12 points is most often used. Remember, the
zoom value could make text appear larger or smaller if a value other than 100% is
selected. As a reference, 72 points = 1 inch.

J. Allen Olshen
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Chapter 5 - Modifying Paragraph Formatting
We may need to modify entire paragraphs within our Microsoft Word document. This
guide will help you modify paragraph formatting quickly and easily.

Paragraph Alignment

Multiple options for paragraph formatting are at our disposal. Below are a few of the
basic skills for accomplishing paragraph formatting.

1. Select the paragraph you wish to modify (using the methods previous
discussed in “Selecting Text”).

2. From the toolbar, click on the Center (alignment) button. The Paragraph
dialog box appears. Note the multiple different options available to us.

3. Try the remaining alignment options using the Toolbar. Revert back to Align
Text Left when finished.

Changing Paragraph Line Spacing

1. From the toolbar, click on the Line Spacing drop-down list . Notice the
options available. Click on the 1.5 option from the list.

2. Try the remaining Line Spacing options using the toolbar. Revert back to 1.0
when finished.

Paragraph Tabs

Next, we will discover the simple usage of the Paragraph Tab. A tab only affects
the first line of a paragraph, while all other remaining lines remain stationary. This
paragraph has a tab at the beginning.

1. Position your cursor at the beginning of the paragraph you wish to indent
with a tab.

2. Press thev (Tab) key on your keyboard. Note only the first line of the

paragraph has changed.

J. Allen Olshen

J. Allen Olshen

Align Left

Center Align Right

Justify

NOTE – From the Toolbar we have a variety of paragraph functions (Align Left,
Center(ing), Align Right, Justify, Line Spacing, Numbering, Bullets, Decrease Indent,
Increase Indent, and Borders.
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Paragraph Indenting

We will discover the available options associated with Indenting a paragraph. This
changes the left margin for only the selected paragraph (or the paragraph where your
cursor is located).

1. Position your cursor anywhere within the paragraph you wish to modify.
2. From the toolbar, click on the Increase Indent button. Note the entire left

margin of the paragraph has changed ½ inch to the right.

3. Press the Increase Indent a second time. Note this time your paragraph is
indented an additional ½ inch.

Another type of Indent is called Hanging indent. It is used at times to offer a more
profession look to your document.

1. Position your cursor anywhere within an ordinary paragraph (no special
indents or alignment).

Note, on the left side of the Horizontal ruler, there are three markers.
These three markers represent the left alignment of the paragraph. The
marker we wish to adjust is the middle marker (appears as a house).

2. From the Horizontal ruler, select the indent marker (shown).
Ensure your mouse pointer is pointing exacting in the center of
the marker.

Although you are pointing and dragging the (house) marker, both it and the
rectangular marker underneath will move together.

3. Click and drag the indent marker to ½ inch on your horizontal
ruler. You have just created a hanging indent.

Another method of creating a hanging indent is accomplished by clicking on Format
from the menu, and then selecting Paragraph, the Paragraph dialog box appears.

Under the Indentation category, locate the Special subcategory and select Hanging
from the drop-down list and adjusting the value in the By field.

Decrease Indent Increase Indent

J. Allen Olshen
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Chapter 6 - Document Formatting and Tools
There are additional tools available that affect the entire document. These features will
be discussed in this section.

Margins

We can change the Margins in our document and they are often changed for the
entire document. We will discuss the process of changing your margins of your
document.

1. Your cursor may be located anywhere within your document to proceed with
modifying the margins.

2. From the File menu, select Page Setup. The Page Setup dialog box
appears.

3. Note the Margins tab is selected. Change the Left and Right margin values
to ½” (.5). You may accomplish this by either clicking on the appropriate
spinner buttons or by highlighting the existing value and typing the new
(decimal) value for each margin setting.

4. Note the other options for Page Setup.

J. Allen Olshen
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5. When finished selecting your options, click the OK button. The changes will
occur for the entire document.

Spelling and Grammar Check

You’ve probably noticed all of those red and green squiggly lines under some of your
text. Those are spelling and grammatical errors. We will discover how to correct those
errors quickly, by using the power of the Spell and Grammar checker.

1. It is strongly advised to position your cursor at the beginning of your
document. You can perform this with a simple keystroke. From your keyboard

pressb +g. Your cursor will immediately position itself at the top of

the document.
2. Launch Spell and Grammar by clicking on the appropriate tool in the

toolbar. The Spelling and Grammar dialog box appears.

3. The Spelling and Grammar checker has located the first questionable error
it has encountered.

J. Allen Olshen

NOTE – The minimum margins available is dependent upon the printer associated
with your computer. If no printer is setup, you will be warned to establish a printer
setup first.



14 CHAPTER 6 - DOCUMENT FORMATTING AND TOOLS

4. From this dialog box, we see the numerous options available. The following is
a brief explanation for each function.

5. When the Spell and Grammar checker is finished, the confirmation
Microsoft Office Word – The Spelling and grammar check is completed
appears.

6. Click on the OK button.

Thesaurus

The Thesaurus is a valuable tool if you can’t recall a word that you wish to use in your
document. Its power is almost limitless. We will discover how to use this tool to our
advantage.

1. Click within a word that you wish to search for alternate words.
2. From the Tools menu, point to Language followed by click on Thesaurus

(shortcut key:j +r). The Research pane appears.

3. Locate a word in the Thesaurus category that you wish to further look up and
click on the word. Microsoft Word will look up the selected word.

4. Once you have located the word you wish to replace, move to the right of the
entry and click on the drop-down list and select Insert. The selected word has
replaced the former word in your document.

5. When completed, you may choose to Close the Research pane by clicking on
the Close button for that pane.

Function Action

Ignore Once This option ignores the error and advances to the next error
Ignore All This ignores ALL instances within your document

Ignore Rule (Grammar) Ignore grammar rule for this instance only
Next Sentence (Grammar) Skip to next sentence (without making changes)

Add to Dictionary Add this word or set of characters to your custom dictionary

Change This changes the current text to the highlighted suggestion
Change All All occurrences that match this error will be changed

Explain (Grammar) Explain rule used for grammar checking

AutoCorrect This corrects entries with the AutoCorrect entry

Close Research Pane

J. Allen Olshen
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Chapter 7 - Printing
For various reasons we may want to have a hard copy of our document. This is easily
accomplished by using the Print function within Word.

Printing a Document

In this lesson we will examine the features associated with printing your document.

1. Start with an existing document open. From the File menu, choose Print.
The Print dialog box appears (depending on your specific printer this dialog
box may differ).

2. Note: if you have multiple printers you may select the correct printer from the
Name field. Click on the drop-down arrow and choose the appropriate
printer.

J. Allen Olshen
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3. Notice the Print range options. The following table briefly describes each
option.

Selection Action

All Prints the entire document

Current Page Prints only the page where your cursor resides
Selection Only prints the highlighted portion of your document

Pages Prints the numbered pages provided (i.e. 1,3,8,10-15)

4. Examine the other printing options available to you. When you are ready to
print, click on the OK button. If you do not wish to print at this time, click on
the Cancel button.
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Chapter 8 - Document Recovery
You never know when an interruption of power to your computer may occur. If you
ever have to recover a Word document after a power failure, following these important
steps:

1. Launch Microsoft Word.

When you open Word, the Document Recovery pane will appear. Any previously
opened (and not saved) documents will appear.

2. Position your mouse pointer along the right side of any Available files. Click

on the arrow and a drop-down menu will appear. Take the appropriate

action: View, Save As, Close or Show Repairs (if available).

J. Allen Olshen
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